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Learning Outcomes

By the end of this unit the learner will be able to:

 Recognize the obstacles that prevent us from effectively managing our time
 Use a planner
 Write everything you need to remember in your planner
 Use a to-do book
 Understand the basics of an Excel spreadsheet

UNIT-7 Managing Time with Excel



TIME MANAGEMENT

P a g e 2 | 92

Unit 7

Managing Time with Excel
It doesn’t matter if you love them or hate them; computers are here to stay. When you combine effective time
management techniques with the proper use of a computer, you are well on the way to getting things done and
keeping yourself organized. In this book, we will combine effective time management strategies and Microsoft
Office Excel 2007 together to help you stay focused, organized, and productive.

In the first two Modules, we will provide a quick refresher on using Excel and show you how you can set up Excel the
way you like it BEFORE you start to work. Module Three will show you practical ways to use Excel and help you keep
track of the things you need to do. Module Four will delve into strategies to help you find the things you need: both
electronically in your data but also physically while in your workspace.

The Power of Change
It takes time to make time work for you. If you are truly going to make any difference in your life because of today,
you have to be prepared to make some changes.

There is a very expensive weight loss clinic in New York State that won’t take people who aren’t prepared to make
small changes in their life. They arrive at the clinic expecting to get a diet that will make them thinner. Instead, they
are asked to go home and fill out a journal of all the changes they can make in their lives in a week. They may want
to drive to work a different way or sit at a different place when they sit down to a meal. They may try sleeping on
the other side of the bed or making little changes in their early morning routine.

When people go back to the clinic at the end of the week, staff members evaluate the changes the person was able
to make. If these changes aren’t successful, they are not accepted into the program. They are told, “If you can’t
change these small things, how will you make the major changes required to learn new ways of thinking about
food?”

Are you truly ready to try making a few changes after today? If so, this book will teach you how to develop good
time management habits and demonstrate how to apply these skills using Microsoft Excel 2007.

 What do you believe are your top three priorities/objectives in your position?

 What do you believe are the top three obstacles to working on your priorities or meeting your
objectives as the moment?

 On a scale of one to ten, how organized would you rate yourself?

1 2 3 4 5 6 7 8 9 10
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 What are the top three things you think you must do in order to be more organized?

 What would you do with any additional time if you found a way to give it to yourself?

What do you believe are your typical strategies for managing your work and your time?

Most of us try one of the following techniques when we get snowed under:
 Work harder
 Work faster
 Get organized
 Have you ever tried these three techniques to get back on track? How successful were they in helping

you?

We all have the power of choice. Your organizational style is a result of the choices you make on a minute by minute
basis.

 Can you give some examples of how choice affects the way you work?

 What is the one activity that you know if you did superbly well and consistently would have
significant positive results in your personal life?

From the experts… (http://www.synergyinstituteonline.com/detail_article.php?artid=387, Tristan
Loo, 2007)

Most forms of change are tough at the best of times, so keep these five things in mind when tackling
a bad habit.

1. Learn to identify your bad habits. Don’t be embarrassed to ask for help from others!
2. Understand why those habits exist in the first place. What things do you have the ability to

change that will help you beat the habit?
3. Design a new good habit. (We hope the information in this book will help you become more

effective at managing your work and personal time.)
4. Create an action plan for that new good habit. In a perfect world, how can you make it

happen?
5. Take the top three actions that will help the most with your new habit and do them every

day for twenty-one days. Most experts that study behavior recognize that twenty-one days
of consistent practice is usually enough time for people to form a new habit.
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 If you know these things would make such a significant difference, why are you not doing them now?

Case Study: Another Day at the Office
It was 7:20 a.m. when Myron arrived at the office. He was early because he wanted to clear the backlog of work that
had been piling up on his desk. He turned on the lights and started to go through yesterday's e-mail. As he read the
first message, he realized he couldn't deal with it until a colleague arrived. He set it aside and went to the next. This
item had potential application to a project he was working on, so he walked down the hall to the printer and made a
copy for his personal use.

As he continued reading his e-mail he came across a journal article of particular interest and become engrossed in it.
As he looked up, he was startled to find that others were arriving and it was nearly 9:00.

He ignored the rest of his e-mail, moved a pile of papers to a corner of his desk and opened a spreadsheet due
tomorrow with at least two days of work yet to be completed. As he opened the file, Bill and Claire stopped by and
invited him to join them for coffee. Myron decided he could spare ten minutes. Bill and Claire were both anxious to
share the details of a play they attended last night. Before Myron realized it, thirty minutes had passed and he
hurried back to his office.

As Myron entered his office, the phone rang. It was Mr. Wilson, his manager. There was a meeting scheduled at
10:00. Could Myron sit in for him? There was something to be discussed that the department should know about.
Myron looked at his watch. There wasn't enough time to get started on the project so he pushed the file aside and
vowed to start it immediately after lunch.

The afternoon wasn't any better. A few visitors, a few phone calls, a couple of letters, and the day was over. Nothing
had been accomplished on the project that was due tomorrow. As he stuffed papers into his briefcase, he wondered
how Bill and Claire were able to attend plays during the evening.

 Did he make good use of his best time of day?

 Did he work on his high priority items?

 Did he have a problem saying no?

 Did he complete the tasks he started?

 Did he understand his problems?

 What would you recommend for Myron?
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Planning Tools

Guidelines for Efficient Planning

 You can save yourself an hour a day by getting organized.
 It is important to identify and operate within two time horizons: short and long term. Anticipating events allows you to

get things done in the short term which contribute to achieving long-term objectives.
 An up-to-date master calendar can be your most helpful planning tool. However, detailed project plans should be

developed before you make entries on your master calendar.
 When things begin to get hectic, a "Things To Do Today" list helps focus attention on the highest priority items.
 Action planning worksheets, milestone charts, and PERT (Program Evaluation and Review Technique) diagrams are

excellent planning aids when properly used.
 Planning contact with colleagues and staff will help minimize disruptions. Keep a file for each person you meet with on

a regular basis, with items to be discussed.
 The most effective approaches to planning are those tailored to meet individual needs. Concepts, procedures, and

worksheets should be modified to fit individual circumstances.
 Experts say nothing should be attempted without prior planning, but there must be flexibility. Remember Murphy’s Law:

If something can go wrong, it will.

Five Point Planning Check

For every plan you make, cover all these points:
 What
 Where
 When
 How
 Who

Five Minutes Before the Hour

If you have a desk or other surface that is cluttered, set aside five minutes at the end of each hour to clear off one
small part of it. This goes for your electronic files too! At the end of your five minute session, set a timer for fifty-five
minutes so you’ll remember the next five minute period.

What can you get done in only five minutes? Try it - you’ll be surprised. At the end of two weeks you’ll see a vast
improvement. This example of instant success will bring a feeling of genuine satisfaction.
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Using a Planner

A planner can be your best friend if you know what you want the planner to do and you know how to use it
effectively. Let’s take a look at some aspects and characteristics you should look for when using a planner.

What are your options when choosing a planner?
 A calendar. Like cockroaches, calendars have stood the test of time.
 A to-do list. Someone once said, “Document what you do. Someone is sure to ask.”
 A binder, with room for information, information, information.
 A computer-aided planner with time management software, such as Microsoft Office Outlook 2007.
 A spreadsheet like Microsoft Office Excel 2007 with projects and tasks organized by worksheet in a way that makes

sense.
 The digital alternative like a handheld organizer, smart phone, or Pocket PC: they can even talk to you!

When choosing your personal planning tool you should ask yourself these questions:
 What do you want it to do?
 How big do you want it to be?
 How much do you want to spend?

 Do you currently use a planner?

 What are the essential things to look for when you purchase a planner?

 What are the key strategies for using a planner successfully?

Many types of planners can work, depending on the needs of the individual. Some people want a calendar, a week
at a glance, a space for a to-do list, and room for notes. Others want something so small it fits in a breast pocket. As
for strategies, there will be several suggestions about how people use their planner, but the most important thing is
to use them.

 How do you remember to call Jim next Wednesday? Note it in your planner.
 How do you remember to follow up with a client in six months? Note it in your planner.
 How do you remember to start a project in six weeks time? Note it in your planner.
 How do you remember not to schedule an out of town meeting for your parent’s 50th wedding anniversary? Note it in

your planner.

Once we begin using a planner, we sometimes have a tendency to only make note of meetings we must attend or
other activities that must be completed, without allotting the time required. For example, if you are attending a
meeting that will take up two hours of your time, block out that two hours. Then you have a more realistic sense of
how much time has been used and how much time you have remaining to use. Anything over 30 minutes should
have time booked.

We will explore how you can transfer information from your paper planner to Excel 2007 (and vice versa) in Module
Three. If you learn to effectively use your paper planner in parallel with Excel, then you will be well prepared to
tackle the things you need to get done.
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The To-Do Book

A to-do book is one of the simplest, most effective time management tools out there. It’s easy to use, easy to carry
around, and easy to update and customize. To start, decide how you want to record your tasks. We recommend an
elementary school style scribbler, but you can also use a designated “inbox” or “new stuff” worksheet in Excel.
Don’t discount a regular notepad either, just use whatever works for you.

Next, make sure you write down the date on any important piece of paper. If you’re using a blank page in your
planner or To-Do book, write the date at the top of the page. Then, make a master list of everything you have to do
for home or work. (We suggest that you make different lists for each.) Now, take out a highlighter and highlight the
top three things that you want to accomplish. During the day, every time you complete an item, cross it off. Nothing
feels better than steadily crossing off your list items! This simple action is an excellent way to keep your motivation
high throughout the day because you will have visual proof of your progress!

At the end of the day, start a new page. Write the next day’s date on it. Then, transfer any uncompleted items to
that next page and add all the things you need to do the next day. Highlight the top two items that you want to get
done. When you start work the next morning, add any items that have come up, and highlight your third top
priority.

Some people find that master list really intimidating because you are seeing ALL of your tasks at once. A modified
approach is to lay out your week like this:

Monday Tuesday Wednesday Thursday Friday

Excel already puts you ahead of the game in this department. Each worksheet is already automatically divided into
rows, columns, and cells! List your tasks for each day in each column. (For the sake of simplicity, let’s say today’s
Sunday, and you’re planning out your week.) At the end of Monday, you’ll transfer any uncompleted items to
Tuesday’s column and add any new tasks. At the end of the week, you’ll transfer any uncompleted items to next
week’s list.

This approach can also be used for teams. Take a whiteboard and turn it into a chart like the one above. Then write
each team member’s tasks in a different color using sticky notes or markers. (Sticky notes are useful because they
allow you to easily move tasks around, rather than constantly erasing and re-writing them.)

Whichever methods you end up using, make sure that you stick to them! Don’t rely 100% on your memory if you
need to remember important pieces of information. Write that information down as soon as you have the chance,
and make sure you write that information in the correct place!  Even if you do remember the information on your
own, the worst that can happen is that you’ll be reminded again.
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Now that you understand some of the basics about time management and staying organized, we’ll shift our focus to
show you the basics of Excel. You should do your best to understand how to properly use the tools available to you.

Excel 101
An Excel file is ‘properly’ referred to as a workbook. Each
workbook can contain multiple worksheets. Most people
generalize and use the term ‘spreadsheet’ to denote either a
workbook or a worksheet.

Each worksheet contains columns and rows.

Columns are vertical and are denoted by letters. Since
there are only 26 letters in the alphabet, and the capability
for far more than 26 columns in a spreadsheet, the next
column after column Z is indexed by the letters AA, AB, AC,
and so on until the last column (XFD). That’s 16,000 columns!

Rows are horizontal and are denoted by numbers. Each worksheet contains a whopping 1,048,576 rows.

A cell is the intersection of a row and column.

A range of cells is a block of adjacent cells. To select a range, let your pointer hover over the center of a cell. When
your mouse pointer turns into a thick cross, hold the left mouse button down, and drag your pointer to select a
range. (Selected ranges are highlighted in blue.) Excel denotes ranges in the format: UpperLeftCell : LowerRightCell

In the image below, the range B2:E5 has been selected. Ranges don’t have to be two-dimensional. A1:A5 (a column
of adjacent cells) and B3:B4 (two adjacent cells in the same row) are both valid cell ranges.

From the experts… (http://www.addresources.org/article_day_planner_nadeau.php, Kathleen
Nadeau, Ph.D.)

Any time management resource will tell you to write down EVERYTHING in your planner. However,
a huge list of information is not very helpful unless it has some sort of order. Here are some
recommended categories for your To-Do items:

 Business To-Do’s
 Home maintenance To-Do’s
 Family To-Do’s
 Long-term goal To-Do’s
 Personal goals including fitness, health, down-time, reading time, etc.
 Social To-Do’s



TIME MANAGEMENT

P a g e 9 | 92

You can also select a range by clicking on the first cell in a block that you want to select, press and hold Shift, and
click on the last cell in the block you want to select.

When you select two or more cells, you
should notice some numbers that appear on
the Excel status bar. These numbers,
tell you the average, the count, and the
sum of the data in the selected cells.

Note that this feature was designed
for convenience. The numbers generated
here may not always ‘make sense’ according
to your data. For example if you have
selected three humidity index
percentages in a cell range (such as 30%,
50%, and 60%) their ‘sum’ would be a very balmy140% humidity!

Summary
Technologies come and go, and the nature of your work will likely change a lot over the course of your career.
However, one thing will remain the same for all of us: time. There are still sixty minutes every hour and twenty-four
hours in a day. Learning to make the most of the time you have is key to getting things done well and on time. You
have to be willing to take the time to change in order to drop the bad habits, control procrastination, and get things
done. In order to keep on top of the things you need to do in a day, it is important to get and stay organized and
make sure you have the tools you need to properly do your job.
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Setting Up Excel
In this Module, we will learn how to:

 Use and modify the Quick Access Toolbar
 Change the default workbook settings
 Change the default file format used by Excel
 Control the way Excel calculates formulas
 Change the look of your Excel interface
 Make Excel start when Windows starts

We all know that if you plan to get anywhere with your work, you have to be somewhat organized. Now that we
know the popular planning tools and the basics of Excel, it’s time to move on and discuss the way you can set up
Excel to work for you.

This Module will teach you the ways to make Excel conform to your working standards. Setting up Excel once right
now will save you doing a lot of repetitive work later. And should your work require you to use some of Excel’s other
functionality, you’ll be ready for the challenge by already knowing how to control the way Excel calculates data.

The Quick Access Toolbar
Chances are you’ve used a previous version of Excel in the past. One of the major differences between Excel 2007
and its predecessors is the new graphical user interface. The new user interface does not rely on multiple tool bars
and menus; instead it offers a cleaner and more intuitive tab-based layout.

An important component of the new interface (and a great time-saver) is the Quick Access Toolbar. The Quick
Access Toolbar was designed to be an ‘always on’ toolbar that you can load up with your most frequently-used
commands. When features are added to the Quick Access Toolbar, they can be brought into play with a single click,
even when the associated tab is unavailable.

The Quick Access Toolbar is located in the upper left of the Excel 2007 screen, just to the right of the Office button.
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By default, the Quick Access Toolbar holds three buttons. These buttons are (from left to right) Save, Undo, and
Repeat. Let’s go over the basics of these commands:

Save button Clicking this button will save your current workbook. If the workbook has
not been previously saved, the Save As dialog will open and prompt you
to give the workbook a name.

Undo button This will undo the very last action you performed. If you continue to click
the Undo button, the next most recent action will be undone, and so on.
You can also click the pull-down arrow to show a list of recent actions.
Highlight a previous action in this list and then click to undo all operations
up to and including the highlighted action.

Repeat/Redo button If you want to redo an action (perform an action that you undid with
Undo), you can click the Redo button on the Quick Access Toolbar. If you
click redo multiple times, each successive action that was undone will be
redone.

You can also repeat an action using the Redo button. If you perform an
action on a cell (making it a certain format for example), you can then
click on another cell or select a range of cells and use the Redo button to
repeat the action on the additional cells.

To add a button to the Quick
Access Toolbar, simply right-
click any command in the
Ribbon and click Add to Quick
Access Toolbar.

Here, we are adding the Bold
command.

With the Bold command located
on the Quick Access Toolbar,
you can access it at any time,
even if the Home tab is not currently displayed.

If you wish, you can add a group of buttons
to the Quick Access Toolbar at once.

To do this, right-click on the word that
defines the command group (such as
Clipboard, Font, Alignment, etc.). Then
click Add to Quick Access Toolbar.
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Removing Buttons

It’s easy to remove a button or a group from the Quick Access Toolbar; just right-click the command and
click Remove from Quick Access Toolbar.

You can remove the default commands if you wish.

Customizing the Quick Access Toolbar

Excel 2007 also allows you to customize the Quick Access Toolbar by using the Excel Options screen.

To do this, click the pull-down arrow at the right of the Quick Access Toolbar, and then click More
Commands. This will display the Excel Options dialog, Customization tab.
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This window is easy to use: highlight a command from the list on the left, click the Add >> button in the
middle, and the command will appear in the list on the right.

You can choose from groups of commands by selecting a command category in the Choose commands from: combo
box.

Once you have added commands to the list on the right, you can change icon position in the Quick Access toolbar by
highlighting an option and then clicking the up or down arrows on the far right side of the screen. Remove a
command from the Quick Access Toolbar by highlighting it in the right-hand list and then clicking Remove (just
beneath the Add >> button.)

The Quick Access Toolbar can also be customized for use with a specific file. Open the Excel file you will use, create
your custom toolbar as described above, and then use the combo box in the upper-right side of the window to
specify that these commands are to be used with the current file. The next time you open the file, the Quick Access
Toolbar you specified earlier will appear.

At the bottom of the dialog, you can specify if you want the toolbar above or below the Ribbon.

Click the Reset button near the bottom of the dialog to restore the toolbar to its default (Save, Undo, Repeat).
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Changing your Worksheet Default Settings
If you always like to work in a particular font or know that every workbook you will create will follow some
guidelines determined by your company, it’s a lot easier to make Excel conform to your standards once instead of
performing the same actions over and over again.

If you prefer to do most of your work with a particular font style and size, but you don’t like the inconvenience of
selecting a new font and font size every time you start Excel, you should consider changing the default font and font
size in the Excel Options window.

To change the default worksheet settings, click the Office button  Excel Options and then click the Popular
tab.

Then look under the When creating new workbooks heading:

From the Use this font drop list, select the font face that you prefer. Next, select the default font size. The Default
view option lets you choose between Normal, Page Break Preview, and Page Layout View. And finally, choose how
many worksheets you want when creating a new workbook.

If you change the default font face, you will be required to restart Excel in order for the changes to take effect:

Changing Your Default File Format

If you find yourself constantly saving files as another file format (other than Excel 2007’s default format of .xlsx), you
can change the default file type from Excel 2007 to another type that is more appropriate to the work you are doing.
For example, you may be using Excel 2007 to create several workbooks that must be compatible with Excel 97 or
Excel 2003. Rather than specifying this file type in the Save As dialog whenever you save a workbook, you can make
this your default file format in the Excel Options window. You can also change the default folder where your
workbooks will be saved.
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Note that a lot of the new graphical components such as SamrtArt and graph/chart display options are only available
when using Excel 2007. If some of these new components are present in a workbook and you try to save the file in a
previous Excel format, you will likely encounter several compatibility issues. Use the Compatibility Checker (click
Office menu PrepareRun Compatibility Checker) to address these before saving the document.

To change your default file format, click Office menu Excel Options, and then click the Save tab.

Select the file format you want as your default from the “Save files in this format” drop list.

You can choose from many options such as many different Excel versions, a Web page, plain text, XML, CSV,
OpenDocument Spreadsheet, and more.

Use the AutoRecover feature to specify how often Excel will automatically save your file. Beneath AutoRecover, you
can specify where Excel should save any AutoRecover files.

And finally, you can set the default location where any new files should be saved.
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Setting Formula Options
If you use Excel to crunch a lot of numerical data, there are quite a few options available to control Excel’s
calculation fidelity.

To set formula options, click Office menu  Excel Options and then click the Formulas tab.

Take a moment to review the options shown below:

If you let your pointer hover over the information icons ( ) beside some of the options, you will see a brief
overview of that particular option.

Under the Calculation options heading, you will see radio buttons and other controls for specifying how Excel
calculates formulas.

By default, Excel formulas are calculated automatically. This means that when you change a value in a cell that is
referenced in a formula, Excel recalculates the given workbook automatically, finding a new result for every formula
that references the value you changed.

Chances are the Automatic setting will be fine for you, but it can be disabled. For example, you might use a
workbook that contains multiple complex formulas or array formulas that reference very large cell ranges.
Therefore, automatic calculation may be a problem because of the length of time it takes to perform all of the
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calculations required.

If your computer happens to bogs down in a situation like this, you can
specify calculation options manually by using the Calculation
Options command on the Formulas tab.

When you calculate your workbook manually, the formulas in
your sheets will not recalculate every time you change a referenced
value. This can help Excel perform better when you are dealing with a
very large workbook with a lot of formulas to be evaluated.

If you select the “Automatically except for data tables” option, the workbook will be recalculated automatically
when you change cell values, except for the dependent cells that are in Excel data tables.

Let’s return to the Excel Options dialog Formulas tab. On the right
side of the Calculation options area, you will see a check box labeled
“Enable iterative calculation.”

The maximum number of iterations is 32,767.

Iteration deals with circular cell references. A circular reference occurs when one cell contains a formula that
references another cell, which in turn contains a formula or references a cell with a formula that goes back to the
first cell. To make this a little more clear, look at the following example.

Imagine A1 has the formula B1 + 1, and cell B1 has the value 0. In this case Excel will have no trouble calculating the
results of the formula. However, if cell B1 contains the formula =A1, you will be faced with a circular reference (B1+1
and B1=A1 so we have A1= A1 +1). Now a situation occurs where the value of cell A1 depends (indirectly) on the
value of A1. That is, cell A1 is dependent on itself for its formula result. When this occurs in Excel, you will get the
following message.

Most often, Excel users enter circular references by mistake, but sometimes, advanced users create circular
references on purpose. If a circular reference is intentional, putting a check in the Limit iterations checkbox will
permit circular references in your workbooks so you will not see the alert shown here.
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A single iteration refers to one step through the circular formula. In the case of the circular reference described
above (A1=A1 +1), after one iteration the value in A1 should be 1. In the Excel Options window, you can specify a
maximum number of iterations, if you allow circular references by checking the Limit Iterations checkbox. The
default maximum is 100, so for the formula described above 100 iterations should result in a value of 100 in cell A1.

You will also see a Maximum Change field below the iterations field. The value in this field (.001 by default) can be a
limit to the amount of iterations that occur. The iterations will stop when the values in any of the cells in the circular
reference change less than .001 (the maximum change). You can alter the Maximum Change value by entering a new
value directly into the field.

Keep in mind that when you allow circular references in a workbook Excel will not detect a circular reference that
you may enter by mistake. If Excel (or your computer) seems to freeze while calculating a worksheet, you might
have stumbled across a circular reference.

Further down in the Excel Options window, you will see
the Working with formulas heading.

You can use these check boxes to specify how cells are
referenced, if AutoComplete should be turned on for
formulas, and if formulas should accept table names.
By default, all of these options are active in Excel,
except for the R1C1 reference style option.

R1C1 referencing reverses the way Excel refers to cells. Be default, cells are referenced by column/row (B5). The
R1C1 style reverses this convention, referencing cells by row/column (5B).

The final two Formulas option groups deal with Error Checking. Take a moment to look over the options below:
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Under the Error Checking heading, you can enable or disable background checking and you can change the color of
the small triangle that appears in a cell to indicate an error.

Under the Error checking rules heading, you can configure what rules Excel will follow when determining errors.
Unless you have a thorough understanding of Excel errors, it is probably wise to leave the default settings
unchanged.

When you have finished making changes, click OK to apply the settings. Note that in order for some settings to take
effect, you might have to close and restart Excel.

Changing the Appearance of Your Excel Interface
If you open the Excel Options window and click the Popular tab, you will see a section of controls labeled “Top
options for working with Excel.”

The Mini Toolbar appears after you have selected a cell or range of cells and then selected the text in the Formula
bar. The Mini Toolbar offers some basic formatting options for the cell(s):
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Live Preview will show you the effect that a visual or formatting command will have on some selected information.
For example, consider this chart:

A purple style is currently being pointed to; thus Excel has changed the style of the chart to show you what the chart
would look like if you were to click this particular style.

The style of the chart will not actually change unless you click a particular style from the list.

The Developer tab contains commands that allow you to record and edit macros using VBA (Visual Basic for
Applications).

The ClearType option will smooth out the look of fonts and objects in the toolbar to make the commands easier to
see when using an LCD monitor with your computer.

Excel also lets you choose between the standard Blue, Glossy Black, or Silver color schemes.

The ScreenTip style lets you choose the level of detail shown in ScreenTips. ScreenTips are small descriptions that
appear while you hover your cursor over a command. Here, you also have the option to disable ScreenTips.
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Finally, we have the Edit Custom Lists button. A list in Excel is a repeating collection of terms such as the days of the
week, the months of the year, a list of employee names, etc. If you need to enter these values over and over again,
lists can help to save you a pile of time. Let’s go over an example first, and then we’ll show you how to create your
own lists.

Using lists is easy. Imagine you wanted to list the days of the week in a column (or
row) of a spreadsheet, starting with Sunday.

Type “Sunday” into a cell, then point to the black square in the bottom-right corner of that cell:

Now click and drag the black square down the column (or across the row).

Excel will fill in the other days of the week till Saturday, then loop back to Sunday and repeat (shown below on the
left).

Release the mouse button and the values will automatically be filled in (shown below on the right).

Excel comes with four of these lists as standard. They are: the days of the week (like those shown above), the days of
the week in abbreviated form (Sun, Mon,  …), months of the year (January, February, …) and abbreviated months of
the year (Jan, Feb, …).

You can create your own custom lists in one of two ways.  The first method is to type the list of
items in Excel. Let’s assume you have five employees you want to add to a list.

Type their names into Excel, and then select the range of names, like this:

Then open Excel Options to the Popular tab and click the Edit Custom Lists button.
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This will open the Custom Lists dialog. The selected cells will already be entered in the Import list from cells field:

Click OK to define the selected names as a list.

The second way to create a list is to do it manually from inside the Custom Lists dialog. By default, NEW LIST will be
highlighted in the Custom lists field on the left.

Simply click inside the List entries field on the right, type one entry in the list, and then press Enter.

Add one entry per line. When you have completed your list, click the Add button to add the list to Excel’s library of
lists.
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Starting Excel Automatically when Windows Boots
If you wish, you can have Excel start up automatically when you first turn on your computer. To do this, you must
first locate your Windows Startup folder. The Startup folder contains shortcuts to programs and services that will
start automatically when Windows loads.

Once a shortcut to Excel 2007 is added to the Startup folder, Excel 2007 will open automatically when you start your
computer.

Normally this folder has the path C:\Documents and Settings\All Users\Start Menu\Programs\Startup or
C:\Windows\Start Menu\Programs\Startup

You can navigate through the file system on your computer to get to these locations or you can enter the path in the
Run dialog under the Start menu.

When you see the startup folder open, hold the Ctrl key and drag and drop the Excel 2007 icon on your
desktop into the startup folder.

Holding the Ctrl key will allow you to drag a copy of the Excel icon (shortcut) into the Startup folder. This ensures
that an icon for Excel will remain on your desktop.

(If there is no Excel icon on your desktop, you can press the Ctrl button and drag the Excel 2007 menu item from the
Windows Start menu into the Startup folder.)

To prevent Excel from opening automatically, just remove or delete the Excel shortcut from the Startup folder.

Note that you can do this action for any program, but don’t do it for too many at once! Even a modern computer
will become noticeably slower if it tries to open many things at the same time. If you do have to open several
programs, open them one at a time. This will actually be faster than letting your computer start many things at the
same time.
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You can also put individual files into your Startup folder. If the file is recognized by Windows (that is, Windows
knows the program used to open it) the file will open when Windows starts.

If you want to have one-click access to Excel (or any other program) without cluttering up your desktop, you can
simply drag and drop a program icon to the Quick Launch toolbar*, located right beside the Start button.

The Quick Launch bar functions just like the Quick Access Toolbar we looked at earlier, but instead of one-click
commands you have one-click access to a program.

*If you cannot see your Quick Launch Bar, right-click some empty space on the Start bar, point to Toolbars, and click
Quick Launch to add it to your screen.

Summary
Excel 2007 is a powerful program and has the ability to calculate a ton of data. It can create complex graphs, import
and export data to other programs, be incorporated into web pages, and a lot more. But setting up Excel to work the
way you want to every time you want to use it is not an effective use of your time. It’s like taking the tires off of your
car when you’re not driving it, only to have to put them back on again when you need to go somewhere.

Therefore, if you know you are going to always use this font or calculate formulas using that method, spend a little
time now setting up Excel to save yourself a lot of time using Excel later!

The Quick Access Toolbar can be customized to include any command you need, and it can even be customized to
be different for each workbook you use. You should also take the time to explore the other features in the Excel
Options dialog to make the most of your working day.

Module Three: The Four D’s
In this Module, we will learn how to:

 Use the Do, Dump, Delay, and Delegate techniques to help manage our time
 Use the Urgent/Important Matrix and decide which projects are the most important
 Interact with Excel
 Delete data
 Automatically or manually hide data from view
 Create table subtotals
 Use hyperlinks
 Create a special workbook to organize your daily tasks/projects
 Drag, drop, and move cells
 Use Cut, Copy, and Paste
 Use the Paste Special option
 Insert and delete rows and columns
 Use STING to help avoid procrastination

By now, you should have a good understanding of how to set up Excel to allow for maximum productivity. In Module
Three, we’re going to switch our focus to the practical application of time management techniques while using Excel
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2007.

Do, Dump, Delay, and Delegate
Do, Dump, Delay, Delegate: these four D’s can help us manage our time better.

Do it Now
Do you spend a lot of time looking for things? Research tells us that the average person spends about 10% of the day
looking for documents. If that were so, you could gain 5 weeks a year just by getting your retrieval methods under
control! If you do have a filing system, make sure you stick to it. At the end of this Module, we will introduce the
STING technique to help avoid procrastination.

Handle the little things that reduce concentration and cause anxiety, like the clutter on your desk and the smaller
incomplete jobs. This is actually the opposite of prioritizing. Do the quick and dirty tasks NOW! Most of the crises in
our lives are often the result of not handling the little things or not reacting to a niggling feeling that something is
wrong. Ignore the little toothache and you wind up with a root canal.

Another technique is to handle the worst things first. We create more stress and anxiety, and waste more time and
energy, over the things we least like to do. Why not just do them?

Try the salami technique: break things down into small steps and get started. That is how we eat an elephant, one
bite at a time.

Dump
Get rid of things you don’t need. This will take some practice and a hard-nosed approach if you have a tendency to
hang on to stuff. If throwing it out is too difficult, give it away, or ask someone else to throw it out for you. We will
discuss how you can effectively get rid of things later in this book. This concept can also be extended to incorporate
an “out of sight, out of mind” way of thinking. We will show you how you can “get rid” of information not by
deleting it, but by hiding it.

Delay
Occasionally we have legitimate delays, for example, if we are waiting for somebody else to get us information or
complete a task. However, if you have deadlines, pass on deadlines to others as well. Don’t let someone else’s lack
of planning short-circuit your deadlines.

Delegate
Don’t waste your time doing things that somebody else can do, especially if they can do them better than you. Save
your time for those things which you are uniquely qualified to do.
In The Creative Edge, author William C. Miller defines five levels of delegation:

 Tell: “Based on my decision, here’s what I want you to do.”
 Sell: “Based on my decision, here’s what I want you to do, because…”
 Consult: “Before I make a decision, I want your input.”
 Participate: “We need to make a decision together.”
 Delegate: “You make a decision.”

You must find ways to delegate, no matter what your position is. Learn to clearly define who is to do what, then let
go and give the delegate a chance to work on their own.
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There are five steps to the delegation process:
1) Explain why the job is important.
2) Describe what is needed in terms of results (not how, but what).
3) Give the person the authority they need to do the job.
4) Indicate when the job needs to be completed and get agreement.
5) Ask for feedback to ensure a common understanding.

Keep in mind that delegation is not always the superior order the subordinate. We will explore different types of
delegation near the end of this Module.

The Story about Everybody, Somebody, Anybody, and Nobody

There was an important job to be done and Everybody was asked to do it. Everybody was sure that Somebody would
do it. Anybody could have done it, but Nobody did it. Somebody got mad about it because it was Everybody’s job.
Everybody thought that Anybody could do it, and Nobody realized that Everybody wouldn’t do it. It ended up that
Everybody blamed Somebody when actually Nobody blamed Anybody.

 Why do we resist delegating?

 Why do we resist having others delegate to us?

 What are some important things to remember when we delegate?
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Do: The Nuts and Bolts of Using Excel
Chances are you are very familiar with the basics of using Excel. However, a refresher never hurts, and hopefully we
can uncover a new trick you didn’t know about before!

But before we get into practical application, we will discuss a simple yet powerful decision tool, the Urgent vs.
Important Matrix. This tool lets you categorize the things you need to do based on their urgency and their
importance.

The Urgent/Important Matrix
Items are added to this matrix based on these four categories:

 Things that are urgent and important
 Things that are urgent and not important
 Things that are not urgent but important
 Things that are not urgent and not important

Urgent tasks are almost always the ones with a deadline and are assigned by others to you.
Important tasks are defined by the amount of time you want to spend on it. The quality of the finished product is
almost always dependant on the amount of time you can devote to it.

Use the following guide to help you sort your tasks:

In a perfect world, the number of tasks in the Urgent and Important (1) box should be small. By applying effective
time management techniques, you should have a reasonable amount of time available to all of your projects.
However, should outside factors like travel delay or a sudden illness get in the way, use the Urgent and Important
box to prioritize the most critical things that need doing.

Tasks in box 1 can include preparing for a presentation the next day or completing an important contract for a client.

The Urgent and Not Important (2) box will contain most of your day-to-day work. These are the tasks assigned to
you or the tasks that are necessary for the daily operation of your workplace. The tasks listed here should be
straightforward but would have serious consequences if they weren’t completed. The most important thing to
remember when sorting items for this category is to not spend a lot of time doing it. Developing a good daily routine
will make sorting for this category easy.

Tasks in box 2 can include filling out daily report sheets, maintenance work, or dealing with customer issues.

The Not Urgent and Important (3) box contains tasks that are more long-term, and may or may not have deadlines.
These tasks should be well-defined so that once you have taken care of boxes 1 and 2, you can pick up something in
box 3 and work on it until something more urgent comes along.

Tasks in box 3 can include things like product development or tasks relevant to a repeating monthly contract.
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The Not Urgent and Not Important (4) box contains everything else. These are tasks that can sometimes be
automated or may be discarded if they remain stagnant for a long period of time.

Tasks in box 4 can include things like backing up data or a virus scan.

We will make use of the Urgent/Important Matrix later in the Delay section of this Module. You will learn how to
create a workbook to help you record information relevant to your tasks and projects.

In Module Four, we will discuss different ways you can sort and filter you data, both textual and numeric. These
commands will become very useful when you need to sort or prioritize the tasks that you categorized with the
Urgent/Important Matrix.

From the experts…
(http://www.time-management-basics.com/time-management-urgent-v-important2.shtml , March
Ltd 2006)

Anything can end up in box 1 if you leave it long enough. One characteristic of a good manager is to
ask ‘why?’If you find too many items ending up in box 1, take a step back and ask ‘why?’ Learn from
the experience so that it will not happen again.
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Interacting with Excel

The largest part of the Excel 2007 screen consists of a grid pattern of cells. These cells are indexed by letters along
the top and by numbers down the left side. An individual cell formed from the intersection of a column and a row.

The cell with a heavy black border around the outside is called the active cell (cell A1 in the image above.) If you
press the arrow keys on your keyboard, you will move the index of the active cell.

Excel Title BarTabs

Worksheet Tabs Status Bar
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If you hold the Ctrl key and press an arrow key, the
active cell border move to the extreme end of the
row or column of cells you are in, according to what
arrow you press. If you press and hold Shift while
pressing the arrow keys, you will select a range of
cells.  For example, the image at right started
with A1 as the active cell. The range that is currently
selected was done so selected by holding Shift,
pressing the right arrow three times, and the down
arrow four times:

One of the major improvements in Excel 2007 over previous versions is an increased number of cells in your
spreadsheet. An Excel 2007 spreadsheet contains 16,000 columns and more than 1,000,000 rows. This means that
there are more than 16,000 X 1,000000 = 16,000,000,000 individual cells in a spreadsheet!

The panel of buttons and controls across the top of the Excel window is collectively called the Ribbon. If you click
one of the labeled tabs (Home, Insert, Page Layout, Formulas, Data, Review, View), you will see the buttons and
controls in the tab change according to the word you click on.

The Ribbon will grow in commands if you select a special object in your spreadsheet, such as a picture or a graph.
These contextual tabs only appear when a special object is highlighted. In the image below, the Picture Tools –
Format tab is visible and contains commands relevant to tasks you might perform on a picture:
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If you let your mouse pointer hover over most controls in the Ribbon, you will see a ScreenTip appear. This box will
show you the command name and a brief description of the button or control in question. In the image on the right,
you can see the ScreenTip for Conditional Formatting.

Try viewing the different controls available by clicking on each word. Let your mouse pointer hover over the
individual controls and buttons in a tab to see information about them.

About AutoComplete

AutoComplete will help you enter information faster by completing what you type, based on similar information
already entered in the same column. If you enter the name John in a cell, press Enter, and then type the letter J in
the cell immediately below it, AutoComplete will fill in the letters “ohn” to complete the word. Just press Enter to
accept the substitution.

If you have two words with the same first letter in a column of adjacent cells, John and Jack for example, and you
type a J, AutoComplete will wait until you type a second letter to discern the most likely match to complete the
entry.
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We think you will find AutoComplete very useful. If you find it gets in the way, you can disable this feature. If you
want to turn the AutoComplete feature off, open the Excel Options dialog and click the Advanced tab. Remove the
Enable AutoComplete checkmark:

Find and Replace

You might recall that the average person can spend around 10% of their day just looking for stuff, both in their
workplace and in their files. You can search a selection or a worksheet for a particular word or number by using
Excel’s Find and Replace feature.

The Find and Replace command is an excellent way to quickly apply the “Do” mentality. If you need to correct the
spelling of someone’s name or fix a formula, you may as well do it now and stop worrying about it!

To use Find and Replace, press Ctrl + F or click the Find and Select button on the far right of the Home tab.

Either action will display the Find and Replace dialog box, which works well to look for a single item. The Find tab is
automatically selected:
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Type your search term in the Find what text box. Note that the drop down list contains recently used search
terms that you can search for again. Then click the Find All or the Find Next button to search the current
worksheet.

If you click the Find All button, Excel will provide a list of cell references that contain what you are looking for.
Clicking Find Next will take you to the next cell that contains what you are looking for.

If you click the Options button, the dialog box will present a number of options for refining your search.

You can now choose to search within a certain formatting style, within a worksheet or workbook, by rows or
columns, and more.

The Replace command is an extension of the Find command, and a very useful time-saver. If you click the Replace
tab, you will be presented with the option to enter a replacement term for the one you are searching for.

You can also jump directly to the Replace tab by pressing Ctrl + H. The Replace command works in the same way as
the Find command.
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Enter a search term in the Find what field and then enter a replacement value in the Replace with field. Any
matches can be replaced with the Replace button.

If you click the Replace All button, Excel will replace every instance of the word or number it finds with the
replacement term, without waiting for you to click Replace for each one. The Options button reveals the same
advanced options as discussed with the Find command.

You can use Find or Find and Replace on a selection of cells as well. Just select the block of cells you want
to search through, then press Ctrl + F or Ctrl + H. Finally, you can use wildcard characters (* and ?) as well if
you’re not 100% sure of what you’re searching for.

Total Row

You can create and use tables in Excel, even though it might seem a little odd because a worksheet is already divided
up like a table. Nonetheless, you can enter alphanumeric data in a worksheet, insert a table based on the data you
have entered, and then use the table as a single entity rather than a range of cells.
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You may recall that if you select two or more cells with numerical data, some numbers appear in Excel’s status bar
that state the average, count, and sum of the data. When working with a table of numeric data in Excel, you can use
a formal Total Row that provides totals or other information about your table data. If you are working with a table in
Excel 2007 and you click on a table cell, a Table Tools – Design contextual tab will appear:

In the Table Style Options group, check the box labeled Total Row. Clicking on this checkbox will add a new
row to the bottom of the table, with the word Total in the first cell. You can also display this Totals Row by
right-clicking a cell in the table and choosing the Totals Row option from the Table sub menu.

If you click on a cell in the totals row, you will see an arrow appear indicating a drop list.

If you display the drop list from a cell in the total row you will see a number of options. You can select each cell in
the total row in turn and choose an option from the drop list to apply to the particular column of numeric data.

None Shows nothing in the total row for this particular column.

Average Shows the average of numerical values for the column.

Count Shows the number of items in the column.

Max Shows the maximum value of all items in the column.

Min Shows the minimum value of all items in the column.

Sum Shows the sum of numerical data in the column.

StdDev Shows the standard deviation for numerical column data.

Var Shows the variance of numerical data in the column.
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In the following example, the total row shows the “maximum” (most recent) invoice date, the average invoice total,
and a count of the invoice numbers.

 If you resize a table, the Total Row will always stay at the bottom.
 If you enter any new data into the table, the values in the total row cells will be recalculated accordingly.
 If you want to change what is displayed in the total row, you can click on any cell in the row and choose

another option from the drop list.
 You can hide the total row by clearing the Total Row checkbox on the Design tab.

Dump: Getting Rid of Things You Don’t Need
Earlier in this Module we discussed that if you really don’t need something, you should give it away or get rid of it. In
Module Four we will help expand on this concept when we explain how to effectively organize your workspace. But
how about ‘getting rid’ of information when using Excel? In this “Dump” section of Module Three, we will show you
how to not only delete information but actually hide it from view as well.

Deleting Information
You can easily clear the contents of a cell or range of cells. To clear a cell, simply click the cell and press Delete or
Backspace. To clear a range of cells, select the cells and then press Delete or Backspace.

Consider this simple spreadsheet:

You can clear or delete a row or column from the worksheet. If you clear a row or column, you are removing all
information in that row or column. If you delete a row or column, you are “physically” removing it, forcing the data
around the deleted area to move and fill the gap.

Clearing a row or column is easy. For example, let’s clear column C. To do this, click the C column header
(which selects the column), and then press Delete:
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To delete a row or column, click the column or row header to select that column or row. Then you can either right-
click the header and click Delete or click the Delete command in the Cells group of the Home tab.  For example, let’s
delete the third row with the right-click method:

This will automatically move all data under the deleted row up one level:

Sometimes when you use the Delete command, you’ll need to select what Excel should do with the surrounding
information:

If you click OK both the cell contents and formatting will be removed, and the data from the cell to the immediate
right will be shifted left into the now vacant cell. If the Shift Cells Up radio button had been selected, the data in the
cell immediately below would be shifted up into the vacant cell.
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You can also delete rows and columns by clicking the Delete button on the Home tab.

Clicking the small arrow at the right of the delete button will display a menu with options to
delete cells, delete rows, or delete columns. To delete rows, first select a row or rows. Then,
click the Delete Button Arrow to display the delete menu, and then click the Delete Sheet Rows
option. This will delete the row, and shift the below cells up.

To delete columns, select the column or columns you want removed, and then choose the Delete Sheet Columns
option. The columns to the right of the deletion will be shifted left.

Remember, clearing contents only removes the data, while deleting removes data and formatting.

It is important to keep in mind that Excel treats text and numbers differently. A number is seen as a value in Excel,
something that can be used in mathematical operations. Text is often used as labels or identifiers. If you want to
enter a number as text (use a number as a label), put an apostrophe (‘) in front of it.

Also keep in mind that if you delete numerical data, check for any formula errors related to the information you just
removed. If your formula happens to reference a cell that doesn’t exist anymore, you’ll have to replace the data
somewhere in the worksheet and update the formula. You can also press Ctrl + Z to Undo the last operation, but
then you’ll have to rethink your deletion strategy!

Using Automatic Outlining
Now let’s shift our view and talk about hiding information from view. Imagine you are using a worksheet that relies
on very large amounts of data. This workbook also has lots of graphs and formulas and is overall fairly cluttered. The
problem is that you need to show this spreadsheet to other people. You always seem to spend a lot of time scrolling
through the document to show them relevant information.

You obviously can’t delete the data in the worksheet, but you can hide certain portions of the worksheet.

Excel’s automatic outlining feature makes outlining a worksheet fairly straightforward. Automatic outlining works
best with numerical data organized into groups and sub groups by formulas or functions. The following worksheet,
for example, contains monthly financial data for a business, organized into quarterly and yearly totals using formulas
and the SUM function.
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If you look carefully at column A, it’s a little tricky to pick out the Quarterly and Yearly rows. This is a good example
where you might want to hide all the monthly information.

To automatically outline this worksheet, click the small arrow next to the Group button in the Outline button
group on the Data tab.
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This action will display a menu with two options: Group and Auto Outline. If you click the Auto Outline button, the
spreadsheet will be outlined automatically:

You can see the results of Excel’s automatic outline above. All of the original data is shown, as well as outline
grouping indicators and collapse buttons marked with a (-). Also take note of the numbers 1, 2, and 3 in the upper-
left corner. These numbered buttons let you expand or collapse all information in that outline at once. You can see
that the quarters are grouped together to be summarized by Quarterly Totals, and each year has been grouped to
be summarized by Yearly Totals.

Notice also that the columns Supplies, Wages, and Rent have been grouped under Total Expenses, and that there is
an overarching group of all columns under Profit.
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Now that the data is outlined, click the (-) button to collapse the rows/columns within the subgroups.  If you
collapse everything, you end up with this tidy list of data:

The original information is still available in all of its detail, but it is now presented in a summary view, showing only
the yearly profit totals. Of course, automatic outlines will differ from worksheet to worksheet depending on the way
the data is organized.

Click (+) to expand a group of data or click one of the numbered buttons to expand the entire group.

None of the data is missing, it’s just hidden. Did you notice the column and row headings in the image above?
Columns B-F are hidden, as well as most of the rows.
To remove the outlining from your worksheet, choose the Clear Outline option from the submenu under the
Ungroup button.

Grouping Data Manually
Automatic outlining may not be adequate for worksheets with non numerical values or with no distinctive totals
(from formulas or functions).

If automatic outlining does not or cannot organize your data in the way you want, you can manually group your data
as required. Take the following worksheet as an example.
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We would like to group this information according to teams and divisions, but if you use the Auto Outline option
under the Group button, Excel displays the following alert:

Because the data contains no formulas or functions providing numeric totals, Excel cannot implement automatic
outlining for the worksheet. You can, however, create your own groupings by selecting the rows or columns that you
want to group, and then clicking the Group button.

For example, if you select the members of Team 1 (cells B4:B6) and click the Group button on the Data tab,
Excel will display the following box asking if you want to group by rows or columns.
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If you select the Rows radio button and click OK, Excel will provide an outline indicator and a
collapse/expand button for the new grouping.

Look at the numbered buttons in the top left corner.

Clicking 1 will show the first level of detail, and clicking 2 will show the second, more detailed level.
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If you follow the same procedure for cells B8:B10, and then select cells B2:B10 and group them, you will end up with
a worksheet like this.

This image shown above is of the fully detailed view. If you click 2, you will see the team names, not the player
names. Clicking 1 will display the highest level view (lowest detail) of the manual groupings.

In this image you can see that the entire first division grouping has been collapsed from view.

You can also select rows or columns for grouping by dragging your mouse over the column letters or row numbers
accordingly. If you select the rows or columns this way, you will not be asked whether to group by rows or columns,
as the selection you choose will clearly indicate this to Excel.

To remove manual groupings, select the rows or columns corresponding to the grouping you wish to remove
and click the Ungroup button. Select the appropriate radio button and click OK.
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Creating Subtotals
Another kind of outlining or grouping technique available in Excel is the subtotals feature. If you have numeric data
organized with clear column and row headings, you can use Excel to create automatic subtotals and grand totals.
This is similar to the Total Row we discussed earlier.

Consider this worksheet that contains sales information for different products across geographical regions:

To use Excel’s subtotal feature, select the range of data you want to apply subtotals to and click the Subtotal
button on the Data tab.

Be sure to include the column labels in your selection so Excel will be able to discern what numbers to total. For this
example, you could select A1:E10 and click the Subtotal button on the Data tab to show the following Subtotal
dialog.

The “At each change in” combo box gives you options as to the number of rows that will be totaled. Remember that
totals are recalculated every time the values in the chosen column label change.

The “Use function” drop list lets you choose from a list of functions including Sum, Average, Count, Product, and
StDev to apply to your data. The function you choose will be used to calculate the totals.

Under the “Add subtotals to” option list, you can select which columns to apply the totals to. You can apply totals to
a single column or to multiple columns in the selected range.

Finally, there are three check boxes at the bottom of the dialog box that will allow you to:

 Replace any pre existing subtotals
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 Put page breaks between totaled groups so they will be printed on separate pages
 Place the subtotals and grand totals above or below the corresponding data
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If you choose to apply totals to each change in the region column while using the Sum function for the profit
column, and with no page breaks, the resulting worksheet will look like this.

Notice that there is a subtotal for the profit figures at every change in the region value (East, West, South) and a
grand total for the Profit column at the end of the data. You can also see that Excel has provided outlined levels,
collapse/expand buttons, and numbered outline level buttons associated with the totals. These buttons and outlines
work exactly as previously explained. The lower the number on the button, the less detailed information will be
shown.

To remove these subtotals, select the range of data in question (A1:E14), click the Subtotal button to show
the Subtotal dialog box again, and then click the Remove All button.

As you can see, all it takes is a couple of clicks to make well-designed data that much easier to work with.

AutoRecover
Now that you know how to delete information and use groupings, you should be in good shape to control your data.
Unfortunately, there are some things you can’t control, like power outages or your operating system deciding it
wants to crash. These are the kinds of “Dump” we can do without!

Excel’s AutoRecover feature repeatedly saves a copy of the workbook that you are currently using based on a
specified time period. The default period 10 minutes, but you can increase or decrease this time as you see fit. The
shorter the time period, the more frequently Excel will save the current file. This means that if something
unexpected happens, you should have a fairly recent copy of the file.

To change your AutoRecover settings, open the Excel Options window and click the Save tab.
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Under the Save workbooks heading, click on the up and down arrows next to the “minutes” field to specify
more or less time between AutoRecover saves.

When you have finished making changes, click OK to close the Excel Options dialog.
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Delay: Make Excel Remember For You
Excel is used for a lot more than just crunching numbers. Thanks to the sheer size of worksheets, the power of the
average desktop computer, and cheap data storage, it’s easy to use Excel as a basic database. If you primarily use
Excel in your day-to-day work, you can also use Excel to help you keep track of the things you need to do.

The third D stands for Delay. In conventional thinking, Delay teaches us to make sure that others are aware of our
deadlines. If you were creating an important workbook based on data from your accounting department, you would
make sure that the accounting department is aware of your needs and delivered the data to you on time. However,
there’s nothing wrong with making sure that we don’t forget the things we need to do as well!

By now, you may have already given some thought to how you might use Excel to help keep you on track. In fact,
Excel is perfect to use for a lot of the organizational tools we have already talked about in Module One: a To-Do
book, a basic planner, an Urgent/Important Matrix, etc.

Is this section on Delay, we’ll focus on building your own task/project organizer into Excel. But before we start to
build this workbook, we need to talk a bit about hyperlinks. Without these, our new organizer won’t be much more
than a jumble of empty worksheets!

What is a Hyperlink?
A hyperlink is a property that can be applied to text or an image. It creates a one-way connection between the
current text/image and another location. This other location can be somewhere in the same file, in a different file,
on a file across the network, on different computers, or anywhere around the world.

When you click a hyperlink, the file or location that is associated with the link will appear on your screen. The Entire
Internet makes extensive use of hyperlinks to link Web pages.

Traditionally, hyperlinks come in the form of an underlined word or phrase in a bright blue font (Like This). This does
not always have to be the case as hyperlinks can be a word, a phrase, a symbol, or a picture. Each hyperlink has a
statement called a URL (uniform resource locator) associated with it. The URL lists the location of the destination file
or object and what protocol should be used to retrieve it. A typical URL that you see in the address bar of your Web
browser could look something like: http://www.something.org. When you click a hyperlink, the information in the
URL associated with it is used to locate and retrieve the linked file or object.

You can create a hyperlink in a workbook that links to an object located in the same directory or on the same
computer as the workbook. You can also create a hyperlink that points to a Web page, a file on a remote server, or
to a specific e-mail recipient.

Inserting and Modifying Hyperlinks

In Excel 2007, you can insert hyperlinks directly into your worksheets. You might want to insert a link to another
location in the same workbook or to another Excel workbook located on the same computer. You might also want to
insert a link to a Word document or to a Web page.



TIME MANAGEMENT

P a g e 50 | 92

To add a hyperlink, select the cell that will contain your hyperlink and then click the Hyperlink
button on the Insert tab.

This will open the Insert Hyperlink dialog.

You can see four buttons running down the left side of the dialog box under the Link to: heading. You can use these
buttons to create a link to an Existing File or Web Page, a Place in This Document, Create New Document, or to an E-
mail Address. Enter the text for your hyperlink in the Text to display field at the top of the dialog box. This text will
appear as a blue underlined hyperlink in the cell that you have selected.

If you choose the Existing File or Web Page button, you will see a drop list labeled Look in. Use this list to browse
through the various folders on your computer to find the file that you want to create a link to. When you select a
folder or drive from the drop list, the available files or folders corresponding to the selection will appear in the large
center area of the dialog box.

You will also notice three buttons just to the left of the large center area labeled Current Folder, Browsed Pages, and
Recent Files. If you click Current Folder, the files and subfolders of the current folder in the drop list will be
displayed. If you click the Browsed Pages button, a list of the URL’s for Web pages you recently visited will be
displayed. If you click on the Recent Files button, you will see a list of recently accessed files.

If you make a selection from any of these lists the URL (or address) of the file will be entered into the Address field
at the bottom of the dialog box. You can also type a URL for a Web page or remote file, or the path to a local file
directly into the Address field. In any case, the file or object referred to in the Address field will be the target of the
hyperlink.

You can click the screen tip button in the upper right of the dialog box to add a brief comment that will appear when
the mouse pointer hovers over the hyperlink.
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You can use the Bookmark button to link to a specific location (like a cell range) in another Excel workbook. First,
select the Excel file from the list, and then click the Bookmark button to specify the exact location within the
selected workbook.

When you have finished making the necessary entries in the Insert Hyperlink dialog box, you can click OK to
create the hyperlink

To change the text of an existing hyperlink, you can right-click it and edit the text in the Formula bar (because left-
clicking would take you to the hyperlink location) You can also right-click the hyperlink and select Edit Hyperlink
from the drop down menu. This will display the Edit Hyperlink dialog which is very similar to the Insert Hyperlink
dialog.

You can now change the target for the hyperlink, the ScreenTip, or the text to display. You can also remove the
hyperlink from the worksheet by clicking the Remove Link button. When you are finished with your modifications,
click OK to implement them.

(Note that Remove Hyperlink and Open Hyperlink are also options on the drop down menu, available when you
right-click on a hyperlink.)

Hyperlinks will generally appear in one color (bright blue by default) before they have been clicked, and in another
color (purple by default), after they have been clicked. You can change the font color and size for an individual
hyperlink by right-clicking on it, and choosing Format Cells from the drop down menu.
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This will display the Format Cells dialog box, which you can use to modify the font color, size, border, shading, and
alignment of the link.

The method just described will allow you to modify individual hyperlinks To modify the default color and font size
for all hyperlinks, click the Cell Styles button in the Style group on the Home tab to display the pre-set cell styles.
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Find the Hyperlink style, right-click on it, and choose Modify from the menu that appears.

This will display the Style dialog.

Make sure that the word Hyperlink is selected at the top of the
Style box. You should be able to see a checkmark next to the
word Font in the column of check boxes on the left. This means
that the style for hyperlinks currently includes only font
settings. Click the Format button to display the Format Cells dialog
box where you can make changes to the borders, shading,
font size, font color, and alignment for all hyperlinks.

When you are finished modifying the hyperlink style, click
the OK button in the format cells dialog.

You will now see the Style dialog, with checkmarks
corresponding to the style changes you have made. Click the
OK button in the style box to implement the style changes.
Now every new hyperlink you create will have this new style
by default.
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Using Hyperlinks in Excel
To follow a hyperlink in Excel 2007, click on it and hold it until the mouse pointer turns into a pointing hand. When
you see the hand, release the mouse button and the target for the link will be opened with the most appropriate
program for it.

For example, if you click, hold, and release a link to a Word document, the document will open in Microsoft Word. If
you click, hold, and release a link to an Access database, the database will open with Microsoft Access. If you click,
hold, and release a link to a Web page, the page will open with your default Internet browser.

The following worksheet contains two hyperlinks.

The first link is to a Word document and the second is to another Excel spread sheet. The two linked documents as
well as the current workbook are all in the same file folder, though this does not have to be the case.
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If you click, hold, and release the first link (Test.doc), the target document will open in Microsoft Word. If we click,
hold, and release the second link (in cell B11) another worksheet (the link target) will open in Excel.

You can see that the hyperlinks are now purple, meaning that they have been followed.

To remove a hyperlink from your spreadsheet, right-click on the cell containing it and select Delete from the pop-up
menu. This will remove the target information from the hyperlink, as well as the hyperlink text itself. The cell in
question will be left empty. You can also right-click on a cell with a hyperlink, and select Remove Hyperlink from the
pop-up menu. This will remove the target information from the link (the link will not function), but the text of the
link will remain in the cell.
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You can also insert a hyperlink function by clicking the fx button by the formula bar. This will display the Insert
Function dialog, from which you can select the Hyperlink function.

If you click the OK button in the dialog, the Function Arguments box will appear.

In the Link_location field, specify the target of the link. This can be a Web page URL, a local file, a file on a network
server, or simple another cell in the same worksheet. In the Friendly_name field, you can specify the particular text
or number that will appear as a link in the spreadsheet.

When you click OK, the link will be inserted into the spreadsheet.
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You can also specify an image or other graphic as a hyperlink in your spreadsheet. To do this, select the image or
graphic by clicking on it and then click the Hyperlink button on the Insert tab.

When you see the Insert Hyperlink dialog, specify a URL or file location as the target of the hyperlink, and then click
the OK button to associate the linked location to the image or graphic. When you click, hold, and release the image,
the link will be followed to its target just like a regular hyperlink.

Creating a Simple Project/Task Organizer in Excel
Now it’s time to put our knowledge of hyperlinks to work. We will show you how to create a workbook containing
several worksheets that are organized and relevant to the tasks at hand. In the final D, Delegate, we will show you
how to effectively use this workbook.

Do you remember the most important thing about using a planner or organizer? Write down everything, even the
small details. This workbook will let you take advantage of that important rule. The core of this workbook will be a
worksheet labeled “Inbox.” Everything you can think of that might be important to a project should get written
down here. Don’t worry about formatting or neatness here; use this worksheet as a place to clear your head of
details. We will also add a worksheet dedicated solely to creating a big Urgent/Important Matrix.

The Inbox worksheet will contain hyperlinks to the other worksheets. These worksheets (and the hyperlinks in the
Inbox to them) will change as you start and complete projects. However, they will all contain two common
elements: a hyperlink back to the Inbox and a hyperlink to the Urgent/Important Matrix

If you are experienced with Excel, you might be wondering why we are bothering to create hyperlinks when Excel
already provides a list of tabs at the bottom of the Excel window:

If you are dealing with a small number of projects, then using the tabs at the bottom of the screen is fine. However,
remember the title of this section, Delay: Make Excel Remember for You. Most of us are usually involved in a lot
more than we think, sometimes having many projects and tasks on the go at once. You probably won’t work on
more than a couple of projects at a time, but it’s important to remember the difference between “inactive” and



TIME MANAGEMENT

P a g e 58 | 92

“dead” tasks! That’s a lot for one person to remember, so it makes sense to take advantage of extra help.
As stated earlier, the name and number of tasks will vary from person to person. However, everyone’s Inbox and
Urgent/Important Matrix can be designed in a similar way, so let’s take care of the easy parts first.

When you open a new workbook, there are, by default, three new worksheets:

The first two can be renamed “Inbox” and “Urgent-Important,” respectively. The third can be named whatever you
need to name your first project. (Note that you cannot use forward or back slashes in a worksheet name.)

To rename a worksheet, right-click a sheet tab and click Rename, as shown on the left. Then type the new
name and press Enter, as shown on the right.

To create new worksheets, click the Insert Worksheet button, found to the right of the existing tabs.

You can click this button to create as many worksheets as you need, and we suggest you name each new worksheet
as you create them.

Now return to the Inbox by clicking the Inbox tab. At the top of the sheet, you can enter the formula =today()
and then press Enter. This formula automatically displays the current date.
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Once you have added a few project worksheets, it’s time to create the hyperlinks in the Inbox sheet. We suggest you
add these links at the top of the page, underneath the date command.  First, type the name of each project or task
worksheet into a cell:

Next, highlight a cell with the first project name, click the Insert tab, and then click the Hyperlink command. Click the
“Place in This Document” Link to: option and then select the appropriate worksheet:

Note the text box that asks for a cell reference. By default, A1 is will become the active cell in the worksheet once
you click the hyperlink. You can change this vale to reference any cell or range of cells in the target worksheet. When
you click the hyperlink, the referenced cell or cells will be highlighted.

Click OK to complete the hyperlink. In the Inbox worksheet, you should see the new hyperlink. Test it out by clicking
it.
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In the Project worksheet, you might want to identify the project by typing a title, the due date (or estimated
timeframe), and the text “Return to Inbox” at the top of the page.

Note that the due date was entered in A2, but has spread into B2 and C2. Return to Inbox also takes up more than
one slide. In order to take care of possible text overlap, you can merge cells together.  To do this, select A2:C2 and
then click Merge & Center in the Home tab:
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This will combine A2:C2 together into a single cell and center the information (though you can still left or right-align
the data if you wish.) The merged cell becomes the leftmost cell, A2. Cells B2 and C2 do not exist anymore:

Now you can Merge and Center the Return to Inbox text if you wish, make the hyperlink back to the Inbox, add a
hyperlink for the Urgent/Important Matrix, and repeat the naming process for the rest of your task or project
worksheets.

There are lots of other pieces of information you might want to add to a task/project worksheet such as supervisor
(with a hyperlink to their e-mail address), other team members if applicable, or anything else relevant to this
particular task/project. Just don’t overload the top of your worksheet with too much!

Now that the workbook contains all of its necessary parts, it’s time to put it to use. Brainstorm the details of current
or upcoming projects in your Inbox worksheet or, if the details of a task are well known to you, follow your
hyperlinks to the appropriate worksheet and enter them there.

In the final D, Delegate, we’ll use our new tasks and projects workbook and demonstrate how to copy things from
the Inbox to the appropriate task/project worksheet.

We have added a sample task and project workbook to the Activity Files folder accompanying this book. The file is
available in Excel 97-2003 and Excel 2007 format.

From the experts… (http://www.wikihow.com/Manage-Priorities-with-Excel, wikiHow & contributing
authors)

Writing your priorities down on paper works if you’re able to knock them off in an afternoon. With a
torrent of incoming tasks at home or work, many get carried over to the next day (or week or
month). This article describes the steps to create a workbook that can mathematically calculate
approaching deadlines and shifts task priorities accordingly.

This article uses Excel 2003 to create the workbook, but can be created easily using Excel 2007.
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Delegate: Get Things Done
The ability to manipulate your information is crucial to building worksheets and workbooks. To work with your tasks
and projects efficiently, you should know how to cut, copy, and paste single and multiple items. You should also
know how to insert and delete cells, rows, and columns, understand how to use the Paste Special command, how to
drag and drop cells, and be familiar with Excel’s Undo, Redo, and Repeat features.

As we explore the last of the Four D’s, Delegation, we’ll try and put together all of the skills to help you make the
most of using Excel as an organizational tool.

To most people, delegation usually means a superior ordering their subordinate. But actually, delegation can take
many forms:

 Delegation to a peer, such as a request to tech support to replace the toner in the printer
 Delegation to a superior, such as a request for approval before moving forward with a project
 Delegation to yourself, such as committing to complete a task first thing next week

When you delegate tasks to another person, you should try and set up a time to meet well before the completion
date of the task (if applicable). This gives both of you time to consider alternate approaches if either of you
anticipate any problems.

The delegation we’re going to talk about here involves switching roles within yourself, becoming the manager, and
delegating work to yourself from your pool of open projects.  This section will show you the mechanics of using the
tasks/projects workbook we created in the last section. We’re going to use the example of planning a birthday party.

Our birthday party will consist of three different tasks: baking the cake, hiring some entertainment, and decorating.
We’ve created the structure for this workbook, including all hyperlinks, and are now ready to start listing our tasks.
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Dragging and Dropping Cells
We’ve done some early brainstorming for our birthday party in the Inbox worksheet. To make sorting items a little
easier, we can drag and drop information around the Inbox to sort like items together. It is a simple matter to drag
and drop cells, so let’s put the three cake-related items together:

First, select a cell by clicking on it, making it the active cell. When you see the thick black border around
the cell, move your mouse pointer over one edge of the border. You will see your pointer turn into a four-
headed arrow.

Now, hold your left mouse button down and drag the cell contents to a new location.

Note that you can’t drag and drop a cell in between two cells. Excel will prompt you if you want to overwrite the
destination cell’s content. If you wanted to keep all the information in one column, you would have to insert a new
row into the worksheet. We will cover inserting rows and columns later.

For now, we can drag and drop items around the Inbox worksheet wherever we like, because eventually the Inbox
will be empty once all items are categorized.
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If you drag a cell that is referenced in a formula (a single cell, or a selection of cells) all formulas that reference the
cell will be adjusted to reference the new location.

However, this is not the case when a formula references a cell absolutely (using $ in front of the row and/or column
index.) Be careful when dragging and dropping in a worksheet. It is easy to drag and drop cells by mistake when
trying to perform other operations.

We have done the preliminary sorting here:

All About Cut, Copy, and Paste
To be able to move your tasks effectively from one worksheet to another, you must know how cut, copy, and paste
cells. To cut and paste a cell, right-click on the cell and select Cut from the drop down menu.

You can also right-click on a cell, select the Cut option, and then point and click or use the arrow keys to move to
your destination. When you select a destination cell, right-click it and select Paste from the drop down menu. The
data will be relocated in the destination cell and removed from its original location.

Often, data needs to be duplicated in another area of the worksheet without disturbing the original cells. To do this,
use the Copy feature. To use Copy, once again right-click on a data cell, but this time select Copy from the drop
down menu. The cell will once again have a dark and light flashing border. Now move to a new location as before, by
dragging, pointing, and clicking, or by using the arrow buttons.
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The data will be pasted to its new location, and the original cell and data will remain unchanged.

How to Cut, Copy, and Paste Multiple Cells and Items

Cutting copying and pasting multiple cells is just like cutting copying and pasting single cells. The important
difference is that you must select a range of cells first.

To begin, select a range of cells by dragging the thick cross pointer.

When you have made your selection, right-click on any cell in the selected range, and choose Cut or Copy from the
drop-down menu. The selected range will have a light and dark flashing border.

If you cut a selection of data, it is just like cutting a single cell in
the sense that the cell information in the original selected area
will be removed (cut) from the worksheet. Paste the copied data
into its new location:

Note that the “fix oven element” item is in the same row as “bake
cake”.” You might want to move “fix oven element” to a new line
and avoid some confusion.
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When you cut or copy items, they are saved to the clipboard. You can view
the items on your clipboard at any time by accessing the Clipboard task
pane. You can do this by clicking the Home tab, and then clicking the small
arrow at the bottom right of the Clipboard group.

Any items copied (up to 24 items) from other Microsoft Office
applications like PowerPoint, Word, or Access, will be saved on this clipboard.
You can paste items to your Excel worksheet (at the location of the active
cell). You can also copy items to the clipboard from Excel, and paste them to
another program like Word.

You can clear all the items from the Office clipboard by clicking the Clear All
button, or you can paste all of the items on the clipboard by using the Paste
All button.

The Cut, Copy, and Paste operations are almost universal across programs
that operate in Microsoft Windows and various Linux distributions. Use Ctrl +
C for Copy, Ctrl + V for Paste, and Ctrl + X for Cut.
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How to Use Paste Special
Paste Special is a very interesting and useful Excel feature. You can use Paste Special to perform a lot of operations
that might be awkward and tedious to perform using other Excel tools. Paste Special does more than just paste data.
It allows you to use the values you will paste to perform operations on the destination cells.

In this worksheet we have the prices for our party entertainment.

As it turns out, a friend of yours owns both of these companies and is giving you a 15% discount off of both services.
Therefore, we can apply a 15% discount to the Cost column of data by using paste special.

To use paste special for this situation, we would enter the value 0.85 in an empty cell, then copy the information in
that cell. The copied value will have a flashing border:

Next, select the column of prices by
dragging the thick cross pointer. When the
selection is highlighted, right- click on the
selected area and choose Paste Special from
the drop down menu.
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This will display the Paste Special dialog box.

There are a number of options In the Paste Special dialog box that you can choose from. Since we want to decrease
the prices in the selected range by 15%, we want to multiply each price in the selected range by 0.85 (the value that
was copied).

Select the Multiply radio button and then click OK.

The prices have been decreased by 15%, the rest of the worksheet has been recalculated.

Remember, you must copy the value or values that you want to paste and then select the cell or range that you
want to paste to, before invoking the Paste Special dialog.

Like the regular copy and paste operation, you can use single or multiple items with Paste Special. You can copy and
Paste Special a single item to a single cell, a single item to multiple cells, and multiple items to multiple cells.

With Paste Special you can choose to add the copied value, subtract it, multiply it, or divide by selecting the
appropriate radio button. You can also choose to paste only values, so a formula will not be copied but its result will.

Take a look at the options available to you in the dialog box, and remember, the default setting under the Paste
heading is All.
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How to Insert and Delete Cells, Rows, and Columns
Earlier, we briefly talked about removing rows and columns from a worksheet. Now we will go over the concept of
removing and inserting cells, rows, and columns.

To insert a column in a worksheet, first right-click on the letter at the top of the column. Click the Insert option from
the menu.

Now, all of the data to the right of, and including the highlighted column, will be shifted one column to the right. In
this example, the data in column B will now be shifted to column C, the data in column C to column D, and so on.

Now there is an empty column where you can enter a new label and data.

This procedure is essentially the same for inserting rows. To insert a row, just right-click on the row number and
choose Insert from the menu. All of the data in the row you selected as your insertion point, and the data in the
rows beneath it, will be shifted down one row. This will leave an empty row where you can enter new data.

It is also easy to delete rows and columns. To delete a column, right-click on the letter at the top of the column and
choose Delete from the drop down menu. All of the data to the right of the column will be shifted one row to the
left, and the old information will be replaced with the data that was in the column to the immediate right.

To delete a row, right-click on the row number and choose Delete from the drop down menu. All of the data below
the column will be shifted up one row, and the old information will be replaced with the data that was in the row
directly beneath.
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To insert a cell, right-click on it and click Insert. The Insert dialog box will appear.

When you insert a cell, the existing data must be relocated. You can click the radio buttons in the dialog box to
specify how the data will be moved. Selecting Shift Cells Right and clicking OK will move the item in the active cell,
and all the items to the right of it, one cell further to the right, leaving a blank cell at the original location. For
example, the data in cell A1 would move to B1, and the data in B1 would move to C1 and so on, leaving cell A1
empty.

Selecting Shift Cells Down will perform a similar operation, but in the direction of the bottom of the worksheet. For
example, if you inserted a cell at location B1, the data in B1 would shift to B2 and the Data in B2 would shift to B3,
and so on, leaving B1 empty.

The Entire Row or Entire Column options allow you to insert a row or a column as previously discussed.

Let’s look at an example. We will insert a new cell at E4 and shift the other cells to the right:
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STING
Most people battle the habit of procrastination (putting off something you really want or need to do) more than
they would like to admit. And in spite of how good you are at setting goals, procrastination can sabotage your
personal and professional life.

Here are five steps to take the STING out of feeling overwhelmed and how you might use Excel 2007 to help.

 S: Select one thing to do.
If you are using Excel to record your to-do list items, it really pays to keep that list as up-to-date as possible. As the old
saying goes, an inch of planning is worth a mile of progress. If you have taken the time to organize and prioritize your
tasks, you’ll always know what you should do next. Keep that list open on your computer throughout the day or save the
file somewhere easily accessible, like your desktop or a handy USB flash drive. A current Urgent/Important Matrix
should make this step easy.

 T: Time yourself. Check the clock, give yourself an hour, and go for it.
You can purchase a simple kitchen timer and have it on your desk to provide a warning when your time is up. Remember
our discussion of the first D – Do it now so it’s done!

 I: Ignore everything else while the clock is ticking.
Don’t check your e-mail, let others know you’re focused on your task, put away your organizer or smart phone. Just
focus on the task at hand. In the next Module, we will go over many techniques to organize your workspace and help
minimize distraction.

 N: No breaks until your hour is up.
This step is really up to you. Sit up straight, make sure you are in a well-lit environment, and take things one step at a
time.

 G: Give yourself a reward when the hour is up.
How you choose to reward yourself is up to you, but we recommend a healthy snack or at least a few minutes to stand up
and stretch.
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Summary
There are lots of different factors that might hinder the way you work. We recommend you keep these Four D’s in
mind: Do, Dump, Delay, and Delegate.

 Do take the time to set up Excel the way you want it to work instead of struggling later on.
 Dump the data you don’t need and try to keep your formatting neat. For information you can’t remove, you

might try instead to group and hide the data.
 Make Excel remember the important things for you by recording important pieces of information about your

tasks and projects. (Just remember to back up your data occasionally!)
 Once you have recorded the important details and are getting down to work, remember that you can very

easily move your data around to make room or cut the information you don’t need.

And when the going gets tough, no matter what you are working on, use STING to stay focused and avoid
procrastination.

Module Four: Finding What You Need
In this Module, we will learn how to:

 Organize your physical workspace
 Recycle what you don't need to keep
 Sort physical and electronic files based on file type
 Deal with e-mail
 Organize your briefcase
 Sort and filter the data in a worksheet
 Use conditional formatting

Organizing Your Workspace
Getting rid of clutter is one of the best things we can do to make a more efficient work environment. Remember
that electronic clutter still counts as clutter!

In this Module, we will go over the basics of organizing your physical workspace. Keep in mind that we’re not
suggesting you use ALL of these sorting and categorization techniques. You can spend too much time doing a good
thing! We recommend you read through the concepts in this Module first and then decide which method or
combination of methods would work the best for you.

Let’s start with your desk. The object of this exercise is to purge both the work surface and the contents of the desk.
If the surface is already clear, good for you! However, if there are items on the desk, ask yourself if they are
necessary and/or in an effective location.

Check position of the desk:
 Is it facing the door and making interruptions more likely?

 Is the lighting adequate?

 Is the phone where it can be reached easily?

 Is there a better arrangement possible?
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 Is the seating/chair adequate?

Your first step should be to get rid of things that should NOT be on the desk. Check everywhere. Look under the
blotter, on the walls surrounding the desk, in trays and drawers, etc. Collect all bits and pieces and de-clutter by
throwing out or noting information in an appropriate spot and discarding it, or filing it for the moment.

Then move to the contents of the desk. Focus first on the tools you use, such as pens, pencils, and erasers.

Check to make sure of the following:

 Do you have all tools you need, and they are in good working order?

 Tools should be organized so like tools are together and easily accessible. Do you need to move any
useless tools? Do any of these tools need fixing or can they be discarded?

 Group like items together (for example: stationery, envelopes, and stamps all in one drawer).

 Store any oversupply is in a supply area. Would anyone else need some of the extra supplies?

 Tools should be stored in a shallow desk drawer, not on the desk.

We recommend you make four piles of all the papers they have strewn around, including those on the bulletin
board, under your ink blotter or desk calendar, and on chairs.

 Take home/get out of office
 Help yourself/giveaways to colleagues
 Cool stuff you want to keep and display
 Things to be filed or written into your planner

Set up a system where vital information is saved where it can be accessed easily, and then bits of paper can be
discarded. Clutter often prevents us from using our time efficiently.

From the experts… (http://www.ehow.com/how_3813_organize-work-space.html, eHow Careers &
Work Editor)

Workspace Tips and Warnings
 Give computer documents logical names for faster recall.
 Try buying an organizer to keep your pens, rulers, scissors, tape, stapler, etc organized.
 Regularly review your filing cabinet, desk, and computer files to discard old materials. If you

don’t already have access to one, invest in a paper shredder.
 Replace things in the same place, every single time.
 Beware of sticky notes – they often fall off or get lost.
 Avoid stacking papers on your desk; you will inevitably misplace important documents.
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Guidelines for Keeping a Piece of Paper

Am I going to need to refer to this later?
YES: File it
NO: Recycle it

Do I have a digital copy that will suffice?
YES: Recycle it
NO: File it

Is it directly related to me or will someone else have a copy that I can refer to?
YES: Recycle it
NO: File it

Do I need to keep this for legal reasons?
YES: File it
NO: Recycle it

Does it fit in my filing system?
YES: File it
NO: Recycle it

If I file it, will I be able to find it?
YES: File it
NO: Recycle it
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Sorting Based on File Type
The key principles of file retrieval are to:

 Group similar things together
 Place them in their own space or container
 Label them clearly

Four Categories
There are also some additional steps we can take depending on what kind of files you are trying to organize. We can
usually divide our files into four categories: Working, Reference, Archive, and Disaster.

Working Files
These include your current projects, routine functions, and quick references. These are the files where you have 80%
of your work. These should be within arm’s reach. They usually contain the following:

 The projects you are currently working on. This file should be cleaned occasionally, to move projects to a reference
file or to eliminate duplication.

 Fingertip information you need on a routine or daily basis, such as phone lists, client addresses, and computer codes.
 A follow-up file for each person with whom you come in contact on a regular basis, where you keep track of all

correspondence with that person.
 A file for routine functions such as sales reports or other functions performed daily/weekly/monthly.

Since these files should be within reach, they might be in a large desk drawer. Make certain they are in file folders,
labeled in large letters, and then placed in hanging file folders that are also labeled.

Usually it is more efficient to label hanging folders by category, rather than by a letter of the alphabet. Then
categories can be alphabetized or color-coded.

Reference Files
These are files you must refer to frequently as you work on current projects. This is where the bulk of your files will
be located. Since you use these files regularly, they need to be kept handy, but not necessarily within arm’s length.
The most important thing is to arrange all information in such a way that you can pull information out of the file
easily.

Key questions for you to consider as this file is set up:
 What do I want to keep?
 What do I need to keep?
 If I wanted this information, could I find it elsewhere?

Information that should be in the reference file includes:
 Research for future projects
 Past projects to which the client refers

It can be helpful to consider key functions or components of your job, and make these the major categories for
reference files. Other files might include:

 Sponsor files
 Administrative information

Cull all duplicates or useless paper. Have a recycling bin at the ready.
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Establish subject categories, and label both file folders and hanging files. Put the file structure on paper prior to
starting the filing.

Label file drawers and create a master list of files if the amount of information is large. Remember to use large, clear
print with a fine tip felt marker.

Archive Files
These are the files nobody looks at. You keep them because the law says you must, or because you are afraid you’ll
need them if they are thrown out, or because nobody wants to take the time to do anything about them. They
should be kept in a designated location far from your work area.

Disaster Files
This is one file that contains all vital information, including identification and financial references, in case you have
to vacate the office unexpectedly. You can also have a file like this at home so you have things organized in the
event of a disaster.

Electronic Files
The key rule is that the file structure used in paper files and electronic files should parallel each other. This is all for
the sake of retrieval. Make use of keywords and search programs to help you find your files even faster.

In this information age, we have to know what we need to keep and what we don’t need to keep. Don’t keep what
you don’t need. Don’t ask, “Will I ever need this?” The answer is almost sure to be “Maybe.” Ask instead, “Where
could I get this if I needed it?”

E-mail
We recommend you check your mail twice a day.

 Checking your e-mail frequently is one of the big time-wasters of the modern office. Avoid it if you can.
 Set aside two periods when you know it will be quiet and check your mail then.
 Use separate accounts for personal and business mail.

Filter the spam.
With all of the junk e-mail circulating today, it's vital to use an e-mail program that can filter it by dumping junk in
the trash before it gets to you.

Most junk mail filters good job of filtering junk e-mail messages, but you should never be 100% reliant on any junk e-
mail filter. Sometimes legitimate e-mail will be filtered as junk and vice versa.

Filters can also help you manage your e-mail better. For example, you can filter mailing list updates, news, and
promotions, into separate folders and read them when you're ready.

Organize your addresses.
Most modern e-mail programs and clients remember the addresses of people that you have contacted in the past. They are likely
stored within the program itself and can’t be directly accessed unless you create a special contact file. Alphabetization is the way
to go here.

File your messages.
Organize your messages into folders or delete them as soon as you're done reading them or acted on them. It’s a
good idea to ensure your Inbox contains only messages you haven't read or that require further action.
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Keep messages simple.
Remember:

 A short e-mail is a good e-mail.
 Use a specific or descriptive subject heading.
 Keep messages, especially replies, short.
 If a simple “yes” or “no” will do, that’s all you need to say.

Briefcase

Your briefcase should be organized with:
 Tools that are needed frequently when away from the office
 Reference files that are frequently referred to such as telephone lists
 Working files that are needed
 A system for expenses

Look at your briefcase or whatever you use to carry important information around with you.

 Are you prepared with extra paper and pens?

 Is your briefcase organized?

 What if someone looked in your vehicle: what does your vehicle say about you?
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Sorting and Filtering Data
The Sort and Filter group (in the Data tab) gives you finer control over how
your spreadsheet data is sorted or filtered. Sorting is the process of ordering
data based on some criteria. Filtering is the process of extracting data from
a larger group based on some criteria.

The two buttons to the left of the main Sort button will allow you to
perform simple ascending or descending sorts.

Clicking the Sort button displays a dialog box that will let you apply multiple sort levels and other criteria to be used
when sorting your data.

The Filter buttons can help you extract certain data from a much larger list or group of data based on criteria that
you can choose or create. The sorting and filtering tools are especially useful for those who may use Excel as a
simple database.

Consider the list of sales data shown on the right. We can apply a
filter to the Rep. column and show only the sales made by a one or two
of the reps.

To do this, select the range of Sales representatives (including
the column header) and then click the Filter command.
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This will add a pull-down arrow at the top of the selected cell range, like this:

Click the pull-down arrow and then use the checkboxes to only show certain data:
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For example, if we wanted to only see the sales made by Alice, we would clear the checkboxes beside Bob and Carl
and then click OK. This will only show Alice’s sales, shown on the right:

Excel is capable of detecting the type of data that has been filtered. In this case, Excel has detected text data
because it is filtering a list of names. Therefore, this Filter menu also offers a Text Filters submenu.

If you have used your tasks/projects spreadsheet and assigned yourself items using the Urgent/Important Matrix,
you could use a text flag indicating the priority. If you then use a filter on your list of text flags, you’ll be able to
choose a project and know exactly what should be done next.

The Text Filters submenu offers more
filtering options:



TIME MANAGEMENT

P a g e 81 | 92

If you are filtering numerical data,
Excel offers a numerical filter as well:
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Custom AutoFilters

With the custom AutoFilter options, you will be able to set up a customized filter for your data table.

To create a custom AutoFilter, select a field heading that you want to filter with and choose Custom Filter
from either the Text Filters or Number Filters submenu.

In this dialog, you can use the drop down arrows and radio buttons to set up filtering criteria for your records. (This
particular Custom AutoFilter is based on a Name field, a field that contains the names of tools. The word ‘Name’ is
displayed in blue in the upper left of the dialog box.)

The first drop list, with the default value equals, will display the following expressions that you can choose to create
a filter:

 Equals (=)
 Does not equal (!=)
 Is greater than (>)
 Is greater than or equal to (>=)
 Is less than (<)
 Is less than or equal to (<=)
 Begins with
 Does not begin with
 Ends with
 Does not end with
 Contains
 Does not contain

The next drop list (on the immediate right) will
contain values from your data table belonging
to the current field. You can see a list of unique
tool names at right:

If you use the And or Or radio buttons, the other
two combo boxes contain the same options as
those described here.
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When you use the And/Or radio buttons to build custom filters, remember:
 For the And option, both conditions must be satisfied for the record to be shown.

I need my towel andmy sunscreen before heading to the beach.
 With the Or option, records that satisfy either condition (or both) will be shown.

I will go to the movie with Alice or Bob.

You can use the radio buttons to combine filtering conditions, or create a filter based on a single condition. To
understand how to create a custom filter with these option lists, look at the following example.

This And condition states that the value for Height must be less than 70 and greater than 63 for a record to be
shown.

You can tell which field has a filter applied to it by the funnel icon that appears on the AutoFilter drop list button.

To remove the filter, just display the drop list, and click the Clear Filter option on the menu.
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Advanced Filters

If you can’t get the results you want from a custom filter, you can construct your own advanced filters to get the
most control over your data tables.

To make an advanced filter, you have to set up a range of criteria to filter your table. Let’s look at an example based
on the Height, Weight, and Age of ten people. We want to show only the records where the Age field is less than 40.
To do this, type a column heading in cell F1 that is the same as the corresponding heading in the data. (The headings
must be identical, as noted by the red arrows.)

Cell F2 contains the criteria <40. To apply the filter, click on any cell in the data table and then
click the Advanced button on the Data tab.

You will now see the data table outlined with a flashing dashed
border, and the Advanced Filter dialog box will be displayed.

When you see the box, make sure the table range is indeed the range
you want to filter. You can then click in the data area labeled Criteria
Range and select the cells that contain your filtering criteria (cells F1:F2
in this case).

The Filter the List in-Place radio button is selected, so the filtered
records will appear in the same location as the original table. Click OK to
filter the List range using the Criteria range as specified in the
Advanced Filter dialog.
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The table has been filtered to show only those records that have an age field value that is less than 40.

To display the full table again, click the Clear button in the Sort and Filter group in the Data tab.

You can set up more complex filters by adding to your criteria range. For example, the following criteria range will
filter the records so that only those with an age less than 40, a height greater than 63, and a weight less than 180
will be shown. Notice that the column headings in the criteria range are identical to those in the original table.

Filtering with Wildcard Characters

Sometimes when you are using a custom filter, or even an advanced filter, it can be difficult to get precisely the kind
of records you want. You can therefore add wildcard characters and fine-tune your filters to retrieve all the data that
you are after.

In Excel, you can use the question mark (?) or the asterisk (*) as wildcard characters. A question mark will substitute
a single character in a string, while an asterisk can substitute multiple characters in a string. For example, the string
“ca?” could be car, cat, can, cap, etc. The string “tele*” could be television, teleportation, telemarketing, and so on.

To see how to use these wildcard characters in a filter, take a look at the following Excel data table.
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If you wanted a list of records pertaining to bears, you could use a wildcard character in your custom filter in the
following way. Remember, you can display the custom filter box by selecting the Custom Filter command from the
AutoFilter drop menus in the Animal column.

To filter our records for bears, we would select equals and type “* Bear” as filtering criteria.

This is the resulting list for the custom AutoFilter. It contains every record from
the table with the word Bear in the Animal field.

Here is another table and custom AutoFilter using the ? and * wildcards.

The first condition tests if Animal equals
L?on. The first condition is combined
with a logical Or to the second condition,
which tests if Animal equals D*.

The Or condition will return the records
that meet either criterion.

The records that have a word starting
with the letter D and the records that have a
four letter word of the form L?on (where ?
can be any letter) will be shown.

It should be noted that the wildcards
do not have to appear at the beginning
or end of a word. They can be used
anywhere in a word to substitute the
characters you want.

For example, “ma*atics” could represent
the word “mathematics” with the *
substituting for the letters t, h, e, and m.

Similarly, “Ro?e” could represent Rope or
Role or Rose or any other word of this form.
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Here are the results of the above wildcard filter:

When using wildcard characters you should be clear on the distinction between the asterisk and the question mark.
“H??se” is not the same as “H*se,” because “H??se” could be Horse or House but not Hose, while “H*se” could be
Horse, House, or Hose.

You can combine both wildcard characters into one term (as in “S*e?), but the resulting records may be surprising
because of the generality of the wildcards. (The example wildcard term S*e? could be Sewer, Softer, Soften, or
Salamander, to mention only a few of the possibilities).

The best way to find out what you can do with wildcard characters is to experiment with them.

You can combine wildcards with an advanced filter to create quite complex and powerful filtering rules. Remember,
wildcards are used to substitute text, not numerical values.
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Conditional Formatting
You have likely heard the financial expressions “in the black” or “in the red.” In Excel 2007 you can design a
worksheet in such a way that data is formatted based on the values the data assumes, such as black and bold for a
profit or red and italicized for a loss. This is called conditional formatting.

To use conditional formatting, first select a range of data that you want to follow your formatting guidelines,
and then click the Conditional Formatting button on the Home tab.

This will display a menu of conditional formatting options. From this menu, you can choose one of the following
options:

Highlight Cells
Rules

This will highlight cells that are greater than, less than, between or equal
to values that you specify.

Top/Bottom Rules This option will allow you to highlight the top or bottom numbers or percent in
the selected cells, such as the top 10% according to value or the ones below
average.

Data Bars Will display colored bars that are indicative of the value in the cell.

Color Scales Will use different shades of color to represent different values, from low to high.

Icon Sets Will use sets of similar icons that will visually indicate a cell’s value.

There are also options at the bottom of the menu for creating a new rule to your specifications, for clearing existing
formatting rules, and for managing rules.
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Each one of the conditional formatting menu options will display either a sub menu or a dialog box. As you let your
mouse pointer hover over an option in the sub menu, you will see a preview of the type of conditional formatting
that your pointer is on applied to the cells that you selected. To apply the conditional formatting, just click the
submenu option of your choice.

You can apply multiple conditional formatting rules to a group of cells by simply re-
selecting the group, and then adding another variety of conditional formatting.
The image at right shows a group of cells with a data bar conditional format and an
icon set conditional format.

The black and red circle icons represent low values, while the yellow and green
icons represent higher values. You can also see that the size of the data bar in each cell
corresponds to the cell’s value.

If you click the New Rule option near the bottom of the Conditional Formatting menu, you will display the
following New Formatting Rule dialog box:

This dialog lets you pick from one of six base rules. The first five rules are all common rules to use with spreadsheet
data, both textual and numerical. But if none of the first five rules work to suit your needs, you can create your own
custom rule based on a formula by choosing the sixth rule.

Don’t forget about the Preview button! Make sure the rule does what you want it to do before you apply it to your
worksheet.



TIME MANAGEMENT

P a g e 90 | 92

If you do apply conditional formatting that doesn’t look as good as you thought it would, use the Undo command on
the Quick Access Toolbar (described in the next module) or press Ctrl + Z to undo the last action applied to your
spreadsheet.

For example, here is a rule set up for cells that contain text starting with “budget.” Look closely at the Rule
Description half of the dialog:

Once you define the rule criteria, you can click the Format button to specify what Excel should do to any data that
satisfy this rule. This will display the Format Cells dialog.

This dialog contains four tabs: Number, Font, Border, and Fill.

Number Format numerical data to account for different currencies, follow
accounting standards, time formats, as fractions, or apply special
formatting like scientific and exponential notation.

Font The Font tab lets you choose the font face, style, size, underline characteristics,
color and other special effects.

Border Use the Border tab to apply colorful/patterned borders to highlight cells that
satisfy your defined rule.

Fill Here you can specify cell color, shade, pattern, and gradient to highlight cells
that satisfy your defined rule.

Click OK when you are finished specifying your format.
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If you want to remove conditional formatting rules, use the Clear Rules option from the Conditional
Formatting menu.

This option will let you clear rules for selected cells or for the entire worksheet.

The Manage Rules option will allow you to delete, edit, or add new conditional formatting rules for the selected
range of cells.
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Summary
In order to be effective at work, it is important to keep your work area and your electronic files organized.
Remember that file retrieval systems work best when like items are grouped together, there’s a place for everything
and everything is in its place, and everything is labeled clearly.


